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1 Introduction

TYKMA Minilase Pro is an application program for the graphic creation of two
dimensional objects for engraving with the TYKMA Laser Systems Utilizing the 5
Watt Laser Engine
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1.1 System requirements for Minilase Pro Laser Software

Windows XP Pro / Windows 7 Professional 32 Bit
Minimum Pentium 4 Processor

Minimum 100 GB Hard Drive Storage System
Minimum 2GB RAM

USB 2.0

1.2 Minilase Pro Installation

The Minilase Pro software program must be installed on a PC with 800 x
600 or higher resolution color monitor.

Follow this procedure to install Minilase Pro onto your Windows computer:

Before installation of the software please follow the Laser System Quick
Start Manual to power up your laser system. Please wait until you are
prompted by the software installation wizard before plugging the USB
connection into your computer.

Insert the provided USB Memory Stick into a USB 2.0 port on your
computer

Browse to “My Computer” on your PC and locate the USB Drive titled
TYKMA Laser Software and Manuals

Right click on the USB Drive and click “Explore”

Locate the icon titled “TYKMA Minilase Pro Installer” and double click
the icon to start the installation process.

You will the follow the prompts as shown below.
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Step 1: Click “Next” to begin the installation wizard:

B Tykma Minilase_Pro Setup [E m

% Welcome to the Tykma Minilase_Pro
Setup Wizard
oo P

This wizard will quide wou through the installation of the
Minilase_Pro 2.0.3 package.

Minilase_Pro package contains the Laser Editor software For
creation of engraving layout, Tyvkma Minilase_ProZ.0 device
driver and other utilities For laser engraving

Please, close all the open applications before proceeding
with this installer,

Zlick Mext o conkinue,

‘minilase

[ Mext = ] [ Zancel

Step 2: Click “Yes” to accept the license agreement after review.

B Tykma Minilase_Pro Setup E] =

License Agreement

Please review the license kerms before installing Tvkma
Minilase_Pro.

Press Page Down to see the rest of the agreement,

PRODUCT LICEMSE AGREEMENT H

WU SHOULD CAREFULLY READ THE FOLLOMWIMG TERMS ARD
COMDITIONSBEFORE INSTALLIMNGTHE SOFTWARE,

B INSTALLING YU ACKMOWLEDGE ACCEPTAMCE OF THESE
TERMS AND COMDITIONS, IF Yol Do MOT AGREE WITH THEM,
WO SHOULD PROMPTLY RETURMN PACKAGE AND YOUR MOREY
WILL BE REFLINDELD,

This product {which includes the documentation and
all other rela_ted material) is Iiu:en_seu:l su:ule_ly For [v]

If wou accept the terms of the agreement, click I Agree ko continue, You must accept the
agreement to inskall Tyvkma Minilase_Pro.

< Back “ I Agrees I [ Zancel
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Step 3: Click “Next” to install the software into the default directory.

B Tykma Minilase_Pro Setup E] i

Chooze Install Location
L Choose the Folder in which ko install Tykma Minilase_Pro.,

Setup will install Tvkma Minilase_Proin the Following Folder, To install in a different Folder, click
Browse and select another Folder, Click Mexk to continue.

Destination Folder

Z:\Program Files\Minilase_Proz, 0

Space required: 26,0MB
Space available; 366,366

[ < Back “ Mext = I [ Zancel

Step 4: Click “Next” to choose the full installation package.
.2 Tykma Minilase_Pro Setup E] m|

£

Check the components vou want to install and uncheck the cormponents vou don't wank o
install. Click Install to start the installation,

Choose Components
Choase which Features of Tvkma Minilase_Pro wvou want to inskall,

Select the bype of install: |Custu:um [v]
O, select the optional Minilase Proz.0
companents yau wish to "

Laser Printer
Laser Device Driver
Deskkop Shorkcouk

install:

Description
Space required: 26.0MB

< Back ” Install ] [ Cancel
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Step 5: As the software installs you will see the following 2 windows. First,

2 Tykma Minilase_Pro Setup B ml 3¢

Installing
Please wait while Twkma Minilase_Prois being installed.

Installing binary files. .,

(RURRI AR ARA AR AR ARRRARNAARRAANS

Copy ko CHiProgram Files\Minilase_ProZ,0YFonks [ |
Create Folder: CiDocuments and Settingsiall UsersiSkart Menu\ProgramsiMinilase_P... |
Create shortcut: C\Documents and Settingstall UserslSkart MenuProgramsiMinilase. ..
Create shorbcut: C\Documents and Settingstall UserstSkart MenuProgramsiiMinilase. ..
Create shortcut: C\Documents and Settingstall Users!Start MenuProgramsiiMinilase. ..
Created uninstaller: C:\Program Files\Minilase_Proz . 0luninstall. exe

Create folder: Ci\Documents and Settingsiall UsersiStart Menu\ProgramsiMinilase_P...
Create folder: C:\Program Files\Minilase_ProZ, 00Doc Ackive

Cukpat Folder: CHProgram Files\Minilase_Proz, 0 Doch Ackive

Exkract: annotaked. bkl

Extract: classes,html Bl
Extract: Funckions. bkl [l

Next you will see the following window appear, when this window is present it is
now time to plug in the USB cable from the laser system into your selected
computer port.

HW Detect

A
=@ Fleaze PLUG USE cable and wait for the device diver being installed|
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Step 6: After plugging in the USB cable you will receive the following message
from windows, please click “Continue Anyway”.

Hardware Installation

'I'\ The zoftware vou are installing for thiz hardware:
"

hasz not pazsed Windows Logo testing to werify itz compatibiliby
with wWindows #P. [Tell me why this testing i imparkant, ]

Continuing your installation of thiz zoftware may impair
or destabilize the comect operation of your spstem
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
paszed Windows Logo testing.

Continue Argway | [§ STOF Installabion

Step 7: Your Minilase Pro software installation is now complete. You may exit the
software and launch the Minilase Pro Laser Marking Software Icon located on
your desktop to begin programming your laser system.

B Tykma Minilase_Pro Setup g =l

a Completing the Tykma Minilase_Pro
Setup Wizard
o d

Tvkma Minilase_Pro has been installed on your computer,

Click Finish b close this wizard,

‘minilase

(

Wisit the Tvkma site For the latest news, FAQs and support

10
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2 Basic Concepts

2.1 Overview

The Minilase Pro software package makes it possible to generate graphic files and
translate them into paths for laser marking and engraving.

Minilase Pro is capable of creating the following objects for marking and
engraving:

Text strings

Customized date and time
Counters

Barcodes

Datamatrix / 2D codes

Vector Graphics (PLT, DXF)
Bitmap Drawings (BMP, JPG, GIF)

Minilase Pro has two separate operating modes:

Work Mode: This mode is for marking and engraving only. In other words,
the loaded laser project file cannot be edited in anyway. In this mode, the
program automatically updates the “active” components (for example the
date or the counter) at each engraving job beginning and end. This mode
can also be protected by password.

Edit Mode: This mode is used for creating/editing laser project files (text,
barcodes, DXF files, etc.) and saving the project files to your hard disk.
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2.2 Creating a new project

When creating a new project, you will first need to select “File -> New” to create a
new file for the laser engraver.

When the new file is created the system will automatically create a “Plain”, which
is a new work area where you may create text, graphics, etc. and align/size the
graphics accordingly. The size of the plain working area will coordinate with the
available marking area of your laser system.

[ Minitase Pro 203 B[]
[ File Mods View Edt Frojsct Actions Zoom Window Lsssr Help BEE:
V@B s | QO =

T [oll 8] &2 2 QaQaq

YT E

P N LI - General | Plain otk | Laser |

Snap and Giid
Snap To Giid

! Gid |
: Origin
: Origin Position | Center

Froject , Plain

Ready MUMOWR

The icon titled 1 refers to the marking plain.

The size of the plain working area will coordinate with the available marking area
of your laser system. The available marking window is determined by the focal
length of the lens installed in your system. (100mm, 160mm lens or 254mm lens)

12
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With the software open you will need to double click the small yellow triangle
icon located in your control panel of your windows toolbar.

o,
-
> k|

Under the tab labeled “corrections” you will need to choose the lens size in the
drop down that coordinates with the installed lens of your laser system.

& Laser Control
Syztem ] Scanner ] Lager Comection l Airning ] [riput # Clutput ]
Dbjective ||

Focal Length [rmm] f = zmall 160mm [100 = 100mm]
Field gide [rnm) f = zmall 100rmm (50 = S0rnm)
Corverson o] = sl 25 140 0
Focuz depth [mm] 2

Field Orienkation
Reverse # axis
Reverse ' axis
Swap =7 ariz

Field Correction
Ize comection file
Offzet = [ptz)] ]
Offzet v [ptz] ]
Scale ¥ [%] 1004
Scale v [%] 1003 =

Ok Apply Cancel

The marking window will now be set so that the software plain work area
coordinates with your installed laser lens and available marking area.

13
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2.3 Language Selection

With the software open you will need to double click the small yellow triangle
icon located in your control panel of your windows toolbar.

&
¥

- A Laser Control

System l Scanner] Lazer ] I:::urrecticunl .ﬁ.iming] [hput I:Iutput]

Language
Autodetect [depeniding on 0.5 lan..
m
Dansk.
German
Englizh
E zpafiol
Francaiz
[taliano
Japaneze
m
Polzki
Swedizh

Firnizh

Ok Apply Cancel

Select the desired language by setting the flag on the right column
Click “Apply” and then “Ok” to have the new language set

To apply the new language, you must restart the software

14



Minilase Pro Software Manual

TYKMA

\\\ TeEcHNOLOGIES

2.4 Minilase Pro work environment

During the creation and editing of laser marking projects, there are a few
commonly used areas of the software.

The plain work area where the graphics/text/objects/etc. are located
The project work area where any sequences and functions are
displayed within the individual project

Property window, where the marking parameters and properties for
the graphics are set

Simulation for displaying a new window with graphical simulation of
the marking that will take place (when no laser is connected)
Toolbar for editing various project and drawing elements

2.4.1 Icons

The following icons form the Minilase Pro Toolbar.

Icon Meaning Icon Meaning Icon Meaning
[ﬂ New . Stop marking c{}b Resize as dominant
& Open Laser test -+ Reflect X
LF] Save \_p Software connected to % Reflect Y

- Laser
[@] Save All ;:3 ISac;fet\rNare ot connected to 0 Cancel transformations
&K Cut Ep Simulation mode Q Group
|:D Copy ™ | Show HW Status £ | Intersect
@j Paste h? Context Help @ Separate
g Undo “'F.T Add string z Refresh view

15
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Ty Main Redo il Add Barcode Zoom Windows

E;ﬁ Add Plain @ Add Matrix code @ Zoom Page

ﬁ Add Clone E“f Import File Zoom Object

j Add Wait for Start O Remove @ Zoomin

4k Add Get and Go Sl:_l Align Left Q Zoom out

‘L\é Add Event é Align Right Show properties

E Add Wait 7O | Align Top Q Hide properties

.ﬁ. Remove Element fllo | Align Bottom \ Reset

. Move up flo | AlignX & Add Line

‘@ | Move down éé Align Y 5 Add Square

DO Red Laser Bfaam Outline on H Distribute horizontally & 4 Add Ellipse
selected object D

% :ﬁi;?:i;Beam Outline on z Distribute vertically \_,jl Add Multicurve Line

. Mode (Edit / Work) ]I Same Width

O Start marking = Same Height

2.4.2 Basic Icon Functionality

Icon Action

16
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Create a new plain work area for inserting text, graphics, barcodes, etc. To
Add Plain be processed by the laser marker
ﬁ Create a Clone of a previously created Plain. The Plain can be cloned if its
ID property is set
Add Clone property
'_D This allow for a pause between one or more plain work areas, where an
additional start signal will be required to finish processing the laser project.

Add Wait for Start This option is best used for objects that may need flipped over or

repositioned to complete the marking process

4p

Add Get and Go

This will allow the project to loop in a continuous manner

=
=
[ ]

Enables the addition of a custom event in the project sequence
Add Event

—

e Allows for the insertion of a timed wait for start

Add Wait

o

Remove Element

Delete an object

Move an object up

Move Up
Move an object down
Move Down
| Turns the red laser pointer outline beam on for the selected object on the
) plain work area

17
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a
o

Limits

Turns the red laser pointer outline beam on for all the objects in the plain
work area

Mode (Edit/Work)

Switches between Edit Mode and Work Mode.
Edit mode is for designing the marking file layout

Work mode is for running the laser marking file

O

Start marking

Start the engraving.

Stop marking

Stop the engraving.

Laser test

Continuously engrave a shape (could be a line, a square or a circle) for laser
focus or testing purposes

Laser Connection

Status:

CONNECTED

Minilase Pro is connected to the laser marking system.

Click the button to switch to the SIMULATOR device.

18
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Icon

Action

(V)
Laser Connection

Status:

NOT CONNECTED

Minilase Pro is not connected to the laser marking system
Possible causes: Power is off, USB Error or possible system fault

Remove the cause of the connection loss and click the button to reconnect.
If the device connection cannot be restored, Minilase Pro switches to the
Simulation mode

EI:;

Laser Connection

Status: SIMULATOR

Minilase Pro is in simulation mode

Click the button to connect to the laser marking system

E=

Show HW Status

Show laser marking system information: Hours, Diode Temperature, Serial
Number, Etc.

Icon Action
Draw a straight line
Add Line
e Draw a square/rectangle
Add Box
> Draw an ellipse/circle
Add Ellipse
'.:"_l
Draw an irregular/straight line
Add Spline

19



TYKMA

Minilase Pro Software Manual \| TEcHNOLOGIES

Alignment

Icon Action

O
[ s
B Align selected objects left in plain work area

Align Left

[}
i
B Align selected objects right in plain work area

Align Right

Align selected objects to their top boundary in plain work area

Align selected objects to their bottom boundary in plain work area

Align selected objects along their center x axis in plain work area

Aligh selected objects along their center y axis in plain work area

20
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Picture Management

Icon Action

el

Space Horizontally

Equally spaces selected objects horizontally in the plain work area

3

Space Vertically

Equally spaces selected objects vertically in the plain work area

—
Set the same width between selected objects in the plain work area
Same Width
ﬁ Set the same height between two selected objects in the plain work area
Same Height
%E: Set equal vertical and horizontal sizing for selected objects in the plain

' . work area
Resize as dominant

|

Mirror selected object in the X dimension

Reflect X
Mirror selected object in the Y direction
Reflect Y
Cancel transformations: takes the selected object back to the original
Cancel .
version
Transformations

21
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Group

Groups selected objects in the plain work area

&

Intersect

Merges selected objects in the plain work area

~

Ungroup

Separates selected objects in the plain work area

e
B

Refresh view
Refresh

22
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2.5 Zooming reducing

By changing the zoom, it is possible to display the entire graphic area on the
screen or a detailed zoom of a particular graphic or area. The maximum zoom
depends on the screen resolution and the dimensions of the graphic area.

To zoom a certain element, select the zoom tool and click on the element

To zoom a specific area in the drawing, use the zoom to trace a rectangular
window around the perimeter
-or select Zoom -> Window

To zoom or reduce the entire window, select Zoom -> In or Zoom -> Out

- -
Zoom  ‘Window  Laser  Help

In ChrlHAlk+PgUp @ @ Q Q 3—53
ot Ctrl+alk+PgDwn { a
Al Crl+alk+Hame t

wiindow  Chrl-AlE
Chject  Chrl+AR+O

2.6 Property window

Project property
The parameters which characterize the various elements or the functions which
make them up are set in the project property window.

Engraving document property

General
The grid characteristics are set on the “General” page

23
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General |F'Iain Wnrkl Lager I

Shap and Grid
Shap Ta Grid

Grid
Size 10

Snap to grid: Enables ability to snap objects to the grid
Grid: Enables grid display
Size: Sets grid spacing

General  Plain ok |Laser I

Wiork, Area
Width 100
Height 100

W argins

nint Area

*width 110
Height 110

Work Area Width/Height Sets the dimension of the work area

Margins XY Sets the width of the margins in the work area

Print Area Width/Height Sets the maximum width of the work area, it is
related to the lens installed on the laser system

Graphic object property

Each object that makes up the laser marking file can be edited using the mouse,
toolbar or “property window” which displays all the characteristic parameters
including size, origins, filling, laser parameters, etc. It is important to note that
also the document itself is an object which properties can be accessed when no
other object is selected. Each graphic object uses by default the laser parameters
of the plain work document. You can set different laser parameters for each
object; in this case, the parameters will turn blue.

24
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Object properties depend on the selected object, this is discussed in the
paragraphs related to individual graphics. (text, bar codes, 2D codes, imported
graphics)

2.7 Setting the measurement unit

Minilase Pro makes it possible to set the linear measurement unit
which characterizes part of the configurations. You can use the
“general” tab located in the project property window and set the
measurement unit in millimeters or inches from the “measurement
unit” menu.

General | Project |

Rezolutions
Linear 0.0
Bngle 1
Relative A

teazure Lnitz

Linear [ ]
Froject (i)

[inch)
I

Resolution

Linear Represents the approximation for linear quotes. Each entered
measurement unit will be approximated to the value set in this box.

Angle Represents the approximation for angle quotes. Each entered
measurement unit in degrees will be approximated to the value set
in this box.

Relative Represents the approximation for relatives, which is expressed in

percentages. Each entered percentage value will be approximated to
the value set in this box.
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2.8 Coloring of graphic objects
The objects in the plain work area may be different colors.

Black — Black indicates that the object is correctly placed within the graphic
area and is enabled for engraving. The object’s engraving parameters are
the standard ones in the document.

Blue — Blue indicated that the graphic object is correctly placed within the
graphic area and is enabled for engraving. Its engraving parameters are
NOT the standard ones

NOTE:

There can be various blue colored objects within the graphic area. Each object
has laser parameters which are different than the standard document ones.
The blue colored objects may have laser parameters which are different from
each other.

Red - Red indicates that graphic object is NOT correctly placed within
the graphic area. A red colored object will NOT be engraved.

Grey — Grey indicates that the graphic object is correctly placed within
the graphic area but is not enabled for engraving. (see the area
highlighted in the property window. A grey colored object will NOT be

engraved.
E Minlrse Fra 103 : = -""_h“d
@B &P T Yololord s

T (sl ¥ (%) bt . Ah2) 2l @Qaeaaq s

1 5 4

||||||||
.....
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3 Creating Graphics

3.1 Minilase Pro Drawing Tools

Minilase Pro drawing tools can be divided into two different categories:

Imported graphics
Minilase Pro objects

3.2 Imported graphics

In Minilase Pro you have the option to import graphics created by other programs
(Autocad, Coreldraw, Adobe, etc.) or you can draw and create simple lines,
curved lines, squares and circles.

The following types of graphics can be imported:

DXF: is a two dimensional vector graphic exchange format primarily used
by CAD applications but available for most vector graphic applications on
the market.

PLT: is a vector format used as an exchange for plotters. The filters are
equipped with vector graphic programs can be used to generate it, or be
installing HP model 7475A plotters in the windows operating system and
printing the graphic created with an application to file.

BMP: is the new standard for bitmap graphics. It can be generated with
any graphics application, from digital camera or scanners.

JPG: is one of the most common compressed bitmap formats. A BMP
image converted into JPG has a much smaller dimension; it is generally
used in continuous tone images.
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GIF: is a format similar to BMP. It can be generated with any graphic
application, from digital cameras or scanners.

Imported graphics can be located in the plain work area and moved,
dimensioned, rotated or transformed so they are compatible for the object you
wish to engrave them on.

Frmens L pm .mg;
’J"JL'JCIE\DUEI QQQQ I8 e 1%
Lo} BE

i
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3.3 Importing graphics with Minilase Pro

After creating a new project, it is possible to import a graphic as follows:
Select: Actions -> Add -> Imported File

The following window will be displayed
Select the file type from the selection box

Specify the path of the file to be imported
Select the file

Look in: | < Local Disk [C:) x| «&BckE-
=] ) 99f314265deddSda5 94
Iaf}a |-5)538ber93ddF 7 caa9fa5hes1 1
My Recent (apps
Documents | " jo1 saa0eecdsese09aaoteczcthiees 2
T ) Documents and Settings
|JDRIVERS
Desktap (0 Inkel
\(Z)Program Files
’___j‘ ) SmartSound Software
I WINDOWS
My Documents )
.|
3
iy Computer
.
My Metwark File name: |cop_l,lright. plt LJ Open |
Flaces
Files of type: |HF'GL 172 files [ PLT " HPGL) ﬂ Cancel |
HPGL 1/2 files [FPLT " HPGL]

AutoCaD DxF files [.DxF)

Bitmap, JPEG, GIF images [*.BMP. " JPG," GIF)
Lazer docurment [*.LOC)

Lazer docurnant x [* LD) !
All Files [*.PLT " HPGL," DXF,* BMP." JPG," LDC." |,

After importing the file inside the plain work area, the object can be manipulated,
for example:

Positioned to set coordinates
Changing the height and width

Filling the object with filler lines (only if the lines comprising the area to be
filled are closed)
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3.4 Information on bitmap and vector graphics

Computers display vector or bitmap graphic formats. Understanding the
difference between the two can be helpful for working more efficiently.

3.4.1 Vector Graphics

Vector graphics describe the images using lines and curves, called vectors, which
all include properties related to color and position. For example the image of a
feather is described by points through which lines pass, creating the form of the
outline of a leaf. The color of the leaf is determined by the color of the outline
and the color enclosed within the outline. In the example described below a black
and white feather is represented because the laser engraving is monochromatic.
When vector graphics are edited, all the properties of the lines and curves which
describe the form are also edited. It is possible to move, re-dimension, remodel
and change the color of the vector graphic without changing its quality. Vector
graphics are not resolution dependent, this means they can be displayed on
output devices with different resolutions with no change in quality.

In laser engraving a vector graphic is faster in engraving and more defined in
terms of outline lines and filling. A vector graphic cannot be used for engraving
digital photographs.
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3.4.2 Bitmap graphics:

Bitmap graphics describe images using colored dots, called pixels, located within a
grid. For example, the image of a feather is described by the specific position and
color of every pixel in the grid and the creation process is very similar to that of a
mosaic.

In the example below, a black and white feather is represented because the laser
engraving is monochromatic.

When bitmap graphics are edited the pixels are edited instead of the lines and
curves. The bitmap graphics change with resolution, as the data which describes
the image is fixed in a grid with specific dimensions. Editing bitmap graphics can
change their quality. In particular, resizing bitmap graphics may make the edges
of the image irregular since the pixels within the grid are redistributed. In
addition, displaying bitmap graphics on an output device with a lower resolution
in relation to the image reduces the display quality.

In laser engraving, a bitmap graphic is slower in completion time and less defined
in terms of outline lines and filling. The best occasion to engrave bitmap graphics
is when you wish to engrave a digital photograph onto a material.
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3.5 Creating basic shapes within Minilase Pro

In minilase pro you also have the capability to create basic shapes such as
squares, circles, lines and curved lines. To create any of these objects you simply
select the desired drawing tool from the toolbar as shown below and simply click
and drag to draw and size the object. Also shown below is the result of any of
these tools.

[= Minttase pro 203 BEX
F\\e Mode Wiew Edit Project Actions Zoom ‘Window Laser Help - 8%
A =53 P
il 24 = H=UE. 7 ) @O O =W
T EI ] L7 caaaqQs
R | IJ O &
P - General ]P\aquuk] Laser |
Snap and Grid
Shap To Grid
Grid
Origin

Origin Posiion | Center

Project , Plain
Ready UM [OVR
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3.6 Minilase Pro objects

There are other types of objects that can also be introduced into the plain work
graphic area.

Text
Barcodes
2D codes

3.6.1 Using the text tool éfr

When text is used in Minilase Pro it is possible to set dimensions, font, style,
spacing, shear and text fill. The text can also be transformed by rotating it,
shearing it and mirroring it, while still maintaining the ability to edit the
characters.

It is possible to insert text boxes in the projects destined for user input or
dynamically displaying updated text, by associating and identification ID to the
text string. It is also possible to place the text inside or outside of a circumference
arc.

Minilase Pro can utilize any type of true type font, including Asian origin ideogram
fonts. To import fonts, see chapter 5, Advanced Features

To add a text string in Minilase Pro: from the top menu select: “Actions” -> “Add”
-> “Text” or use the mouse to click on the “{f_‘fa String” icon on the tool bar.
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3.6.1.1 Selecting text properties

The property window displays the text parameters only when the text in the
graphic area is selected. Typical text parameters are shown on the various pages
in the figure.

General:

Main:

Enable Enables the engraving of the
selected text (if not enabled the text
is grey)

Position XY Sets the text coordinates in relation

to the origin of the engraving area

(0,0 is the center of the area)
Width, Height Sets the text width, height
Maintain Aspect If enabled, keeps the proportions

between width and height

Angle Sets the rotation angle (in degrees)
of the string on the engraving
area

Shear X Sets a shear on axis X. The shear in

the figure is set at “50”
String Soig

ShearY Sets a shear on axis Y. The shear in
the figure is set at “50”.

String 5tﬂ”g
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This is used to move the reference
origin of the string. The origin is
indentified by an X placed in the
center, this can be moved to one of
the four corners of the selected

IBW d

Use to fill a text string. Single pass,
double pass or triple pass

Angle that the beam travels
relative to the object during filling
Represents the value of spacing
between each pass of the laser
beam during filling

When selected the object will not
be outlined after filling is complete

Enable to generate clones of the selected object. Clones

will be duplicates of the original object in a square or
rectangular matrix.

General | Sting | Data | Laser | Origin:
: Position
Main
ID text2
Enable
Position # 0
Position ' 953
Width B6.99
Height 262
Mainaint Aspect
Angle 0
Shear® 0
Sheary 0
Origin
Position Center Fill:
Fill Fill type
Fill Type Single line
Fill option Bidirectional .
Fill by Object Fill Angle
Fill Angle 0
_Fil!Space _[!_1 Fill Space
Fill Tolerance |0
Mot Engave P...
Send path first
_ Clone Object
Enable
Move by # 0
Move by Y 0
Clone Object
Enable
Clones in X
ClonesinY
Offset X
Offset Y
Clones individual offzet
Enable
b owe by = I}
bowe by I}

The number of clones in the X axis
The number of clones in the Y axis
Represents the offset spacing of the clones in the X axis
Represents the offset spacing of the clones in the Y axis

It is also possible to offset individual cloned items
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Example of cloning feature
[ Minitase Pro 203 BEX]
F\Ie Mode View Edit Project Actions Zoom Window Laser Help = 5

VPBIY & IPL»

K2

: @aaaqals

|

T Eﬂ & Rag) ket O
AL & &<
---------------------------------------------------------------------------------------- General | Sting | Data | Laser |
Angle 0
: [Shearx ln
E Sheary EI.
TEXT TEXT
i Fill Type F.“El‘vlngle line:
.F|II aption _Eidileclmnal
Fill by Object
Fill Angle: _U
Fill Space 01
Fill Tolerance _U
Mot Engave P...
| 5end path first
Clone Object
Enable
Mumber of clones
H :E\nnesinx _2
o] & = : Clones in ' 2
R T&T - TEXT i .D"sem Elflsetu_;culones
: N ¥ : .U’FSE‘CTWES indiv?dnua\ offset
Enable
""""""""""""""""""""""""""""""""""""""""""""""""""""""" Moveby  |D
Project %, Plain Move by ¥ 0
STRING
Data:
Text Enter your text here
ID Numeric value assigned to the
object
Style:
Font Designates the font of the text
string (i.e. arial, times)
Height Represents character height (to be
used with circular text)
Angle Angle of rotation of each character in relation to its origin
pomt Example shown is at a 45 degree angle
O R L S v
o] A of
Shear X/Y Shears each individual character on the X or Y axis
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String dizplacernent
Space 100
Compression 100
Pocketing Dist..[0
Embolden stre... |0
Global outline

Circle Dizplacernent
Enable
Radiuz 1]
Counter clock....

Apparent radiuz |0

Inzide
Auto Star Aingle
Fill
Fill Type Sinale line
Fill aption Bidirectional
Fill by Object
Fill Angle n
Fill Space 0.1
Fill Tolerance |0
Mat Engave P...
Send path first

TYKMA
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String displacement:

Space Represents the spacing between
each individual character
(default value is 100)

Compression Represents the compression of
each individual character
(default value is 100)

Pocket Dist. The distance between the fill
and the outline of the object.
When Pocketing distance is
increased, the corresponding fill
is reduced

Embolden Allows for the overfill of the
object, the fill exceeds the
default outline

Global Outline If embolden is enabled, enable
this value to for the laser to
mark the object’s new outline

hat value

Circle Displacement
Enable

Radius

Counter Clockwise
Inside

Auto Star Angle

Enables text wrapping to a circumference

Enter the radius of the circle that the text will wrap to
Wraps the text to the top dimension of the circle

wraps the text to the inside of the circle

Places the text at its origin point at the top center of the
circle at 0 degrees (default checks this automatically)

o] E] &

String

Al
M

Ak
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3.7 Special character sequences

The text string can contain any alphanumeric character and one or more of the
following special character sequences:

%a, %A
%b, %B
%cC

%d

%H

%l

%j

%m
%M

%p

%S

%U

%W
%W

%X

%X

%y

%Y

%z, %Z
%n

%0
%e, %E
%Ss

%%
%ID

Day of the week, abbreviated (a) or full (A)

Month of the year abbreviated (b) or full (B)

Date and time according to current location

Day of the month, decimal number (01-31)

Time 24 hour clock format (00-23)

Time 12 hour clock format (01-12)

Day of the year, decimal number (001-366)

Month of the year, decimal number (01-12)

Minutes, decimal number (00-59)

A.M. / P.M. indicator

Seconds, decimal number (00-59)

Week of the year, decimal number (00-51, Monday is the first day of
the week)

Day of the week, decimal number (0-6, Sunday = 0)

Week of the year, decimal number (00-51, Monday is the first day of
the week)

Date according to current location

Time according to current location

Year, two digit decimal number (00-99)

Year, four digit decimal number

Time zone, name (Z) or abbreviation (z)

Counter, decimal format

Counter, octave format

Counter, hexadecimal format, lower case (e) or upper case (E)
Data from serial RS232-C

Percentage sign (%)

(Percentage sign followed by an ID number) Copies that ID’s data

Example of date in dd/mm/yyyy format
Proceed as follows to make a text string with the format: day (two digits), month
(two digits), year (four digits) separated by “/”:

Create a text string cont. on next page
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Select the required parameters (font, character height, etc.)
Enter the string “%d/%m/%Y” in the text box and press enter

Example of data in dd/mm/yy format
Proceed as follows to make a text string with the format: day (two digits), month
(two digits), year (two digits) separated by “/”:

Create a text string

Select the required parameters (font, character height, etc.)

Enter the string “%d/%m/%y” in the text box and press enter

Example of a counter
Proceed as follows to make a text string including a decimal format counter:
Create a text string
Select the required parameters (font, character height, etc.)
Select the required counter parameters (see below)
Enter the string “%n” in the text box and press enter

General | Sting. Data |Laser | The counter parameters can be accessed from the
Main O ata “Properties” window on the string “Data” page.
The parameters are:
Start, the minimum value of the counter
Stop, the maximum value of the counter
2::2 253 Cycles, the number of engraving jobs required
i i to increase the counter
Step 1 Increment, increment value (positive or
Cycles 1 negative)
Digits 3 Digits, minimum number of digits to be

displayed

For example, with the following parameters:

Current =9
Start =1
Stop =10
Cycles =2
Increment =2
Digits =3

cont. on next page
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The following would appear: “001”
to become: “003”...”005”...”007”...”009”...”002"...”004"...”006"...”008"...”010”

In this example an increment would occur every two engraving jobs.
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3.8 Barcodes and 2D / Datamatrix codes

Barcode

To insert a barcode, click on the Iﬂl icon. A barcode will be automatically
generated on the plain work area.

________________________________________________________________________________________

_________________________________________________________________________________________
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Data:
General Barcode l Data ] Lazer ] i
Text Enter the text to be placed into the
barcode
t 123456 . :
lDEH ID Numeric value assigned to the
barc2 .
object
Code 245 standard Encode
Checksum Code Sets the type of barcode
- Bacods Checksum Enables a checksum calculation on
k . ep s
= - the bar code string (if installed)
Size 033
Ratic 100 Barcode
Quite Zone |3 Height Height of the barcode
Reverse Size Width of the barcode
Module Ratio | 300 Ratio Represents the size of the black
bars in relation to the white bars in
Fill Type Single line . .
Fill option Bidirectional the barcode, utilized to improve
Fill by Object resolution with smaller barcodes
Fill ngle 30 Quiet Zone Sizes the extra space to the right
Fill Space 0.1 and left of the barcode when using
Fill Tolerance |0
a reverse barcode
Mot Engave P...
Send path fist Reverse Makes a reverse barcode (swaps
black and whites)
Module Ratio Controls the ratio of the black and white bars while

simultaneously adjusting the overall width of the barcode
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3.9 Matrix code
e
To insert a 2D or Datamatrix, click on the [E5 jcon. The code will be automatically

generated on the plain work area.

-----------------------------------------------------------------------------------------

_________________________________________________________________________________________
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General [atamatrix l Data ] llﬂ

Text 123456

D matrl

Code Type [ atamatris

Code TEXT encodation

Ermor Lewvel Ecc 200 encodat

Size 18418
Matrnxcode Module

Module Size 1

Module Ratio 100

Quite Zone 1

Reverse

Dot b atriee

Fill Tupe Single line

Fill aption Bidirectional

Fill b Object

Fill &ngle an

Fill Space 0.1

Fill Talerance |0

MHat Engave P...

Send path first

Reverse

Data:
Text

ID

Encode:
Code Type

Code
Error Level
Size

TYKMA

\._ TECHNODLDGGIES

Enter the text to be placed into the
datamatrix code

Numeric value assigned to the
object

Represents the type of datamatrix
Type of encodation

Error Correction Type
Represents the overall code size

Matrixcode Module:

Module Size

Module Ratio

Quiet Zone

Represents the dimension of the
matrix code module in the
engraving area

Represents the ratio of size
between the black squares and the
white squares. Particularly useful
when marking small codes that
require higher resolution - Default
value is 100

Sizes the extra space to the outer
edges of the code when using a
reverse code

Makes a reverse datamatrix (swaps black and whites)
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3.10 Manual Movement of Objects on the Plain Work

Moving the rectangle

Clickon B positioned on the top left and on the bottom left of the object to
move it

Rotating the rectangle

Clickon ¥ positioned on the bottom right of the object to rotate it

Enlarging the rectangle

Clickon = positioned on the top right of the object to enlarge it

Reduce/Increase height/width

Click on # positioned on the top to reduce/increase the height of the object
Click on < positioned on the right to reduce/increase the width of the object
Stretching the object

Clickon % positioned on the left to stretch the object vertically

Click on # positioned on the bottom to stretch the object horizontally

NOTE
A All the above described features can be applied to any element created on
the plain.
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4 Laser Marking Parameters

4.1 Laser Settings

Programming the software to mark the created objects with the best parameters
for the material being marked.

To program the laser settings you will need to click on a blank area inside the
plain work area, making sure no objects are selected. This will allow access to the
tab system for the plain work area, where you will set the laser parameters to be
used on all objects created within the plain work area. Shown below is the tab
system that will be visible when correctly selected.

General l Flain Wnrk] Laszer ]

Snap and Grid
Shap To Grd
Grid
Size 25
Crigir

Onigin Pogihion | Center
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To begin programming the laser settings, you will first need to select the tab

named “laser”.

General] Flain ‘work, ~ Laser l

M aterials
M aterial
Sawve Save
Delete Delete
Parameters
FPaszages 1 paszage
Fazzage -1 -
Power an

Shot Frequency | 20000
Scan Speed 200

Paszes 1
Dot Drelay 5
YWiobble
Enable
Passage
Power

Shot Frequency

Scan Speed
Passes

Dot Delay

Materials
Material

Parameters
Passages

You will then see the following settings.

This drop down box is where you
can access saved laser
parameters. After you discover
the best settings for a particular
material, you can save them with
a custom name in this menu, and
recall them quickly whenever
needed - To save a material type
the name in the material box
area and click save, to delete a
material, select it from the drop
down box and choose delete

Select up to three unique
combinations of laser settings to
be utilized in sequence.

The percentage of available power you wish to utilize
(typically from 70-100%)

This controls the frequency of the laser pulses. The
available range is 10,000khz to 150,000khz. A lower rate
will deliver pulses less often but there will be more
energy behind each pulse and they will generate less
heat on the material being marked. A higher rate will
deliver pulses more often but there will be less energy
behind each pulse and they will generate more heat on
the material being marked.

The speed of the laser beam as it travels across the
material. Range is 10mm/sec to 5000mm/sec

The amount of time the individual passage is to be

processed

When marking bitmaps, dwell time for each pixel
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4.1.1 WOBBLE

The purpose of wobble is to mark the single lines of vector graphics with thicker
lines (either True Type characters or imported figures). The line thickness is
normally equal to the dimension of the laser spot. However, for some applications
this thickness may not be sufficient, the wobble function solves this problem.

The picture below represents the functioning principle of the wobble.

Picture 1 shows the result of a vector marking with the wobble disabled.
Picture 2 shows the same vector but with the wobble enabled.

The conversion of the vector into a dense spiral provides greater thickness of the
engraved line. The same function can be applied to any vector graphic that is
going to undergo plain marking.

@ Diameter Represents the diameter of the spiral
curve

Speed Represents the frequency of spiral
repetition

NOTE
A The wobble function configuration parameters must be tested and
checked in order to obtain the desired effect.




Minilase Pro Software Manual

TYKMA

\-\___ TECHNOLOGIES
4.2 Laser Settings Quick Guide
Material Mark Type Power Frequency Speed Fill Type Fill Angle Fill Space
Steel Black 95 60,000 25 Single 90 .04
Steel Brown/Gold 97 20,000 50 Single 90 .06
Titanium Black 95 90,000 25 Single 90 .04
Aluminum White 97 15,000 250 Cross 45 .06
Aluminum Black 100 20,000 30 Single 90 .05
Brass Brown 100 15,000 30 Single 90 .05
Carbide White 97 25,000 500 Cross 45 .06
Black Oxide Bright 97 40,000 500 Cross 45 .06
Anodized White 97 20,000 500 Cross 45 .05
Plastic Dark 97 20,000 750 Cross 45 .06
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4.3 LASER TEST

1=nne
. A

When clicking the .2 icon. Minilase will generate the following pop-up

Laser test Z E|E|

Lager tezt
Lazer Test
Type Line
Size 10
Prowwer 70
Frequency 30000
Start Test

Laser test functionality is used at the beginning of any operation, in order to find
the right focal point if not utilizing the built in laser alignment tool.
The functionality enables a continuous lasing process.

The following parameters must be inserted:

Laser parameters power, frequency

Type of shape to be marked line, square, circle
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5 Advanced Features

5.1 HW STATUS
Click the D icon to show the Minilase device hardware status.

The Show HW Status window is available only in Work Mode

ULYXE systemn State ]

((minilase”

System information

F'W - LCD Release

FW - TEC Release

| Faosnzoo1_ops
Diode 5/M

| Faosnio0z_ooz
Systemn SN

|LsvLL123456

Diode Parameters

Temperature | 21,37

| ULxo01B3458

Converker Parameters

Temperature | 27,84

Dissipator

R 00.34 Temperature 2743
Supply (2420
voltage 2l
Hour meker - HHHH:MM: 55
Diode System
| 0001729134 ao0z4:55:22

ULYSE syskem Skate

| STAMD-BY - enable shutter for emission

The HW status allows to monitor:

Some System Information (FWs Release, diode Serial Number and
System Serial Number) useful to identify your marking device.

Diode temperature and current.
Converter temperatures and supply voltage.
Diode and system hour meters (working hours).

Device system state.
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The device state reported could be one of the following:
STATUS DESCRIPTION
SYSTEM READY The shutter is enabled for laser emission and the laser system is ready to mark
STAND-BY The shutter is not enabled for laser emission.
WARM-UP . .
Device is warming up
LASER-OFF The laser system key is in OFF position: the laser is not operative.
The following marking functionalities - hence icons - are disabled; turn the key
ON to enable them again
Laser Test
O Start
2 Limit Al
i [T
Limit Object
o J
If the user turns OFF the key during an engraving job (Laser Test, Limit All,
Limit Object) the system State will be updated at the end of the job
FAULT: . There is an internal laser HW problem: switch off the system
Poweroff The device has been powered off
Buffer  overrun:
uUsB bandwidth | The USB communication bandwidth is low: current job aborted
low
The device buffer
contains  invalid | Invalid data to process: current job aborted
data

The working parameters are refreshed any 4 seconds.
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5.2 KEYBOARD SHORTCUTS
Below the list of the Keyboard Shortcuts grouped by Main Menu topics:
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Main Menu topic

Sub Menu topic

Acceleration Key

New project

CTRL+ N

Open an existing project

CTRL+O

Save CTRL + SHIFT +S
File Save with name CTRL+F4
Close CTRL+C
Import graphic file CTRL + SHIFT +1
Export HPGL CTRL + SHIFT + E
Undo CTRL+2Z
Redo CTRL+R
Modify Cut CTRL+ X
Copy CTRL+C
Paste CTRL+V
Add PLAIN WORK CTRL + SHIFT + P
Add CLONE CTRL+ SHIFT+C
Add WAIT for START CTRL + SHIFT +S
Project Add GET and GO CTRL + SHIFT + G

Add EVENT CTRL + SHIFT +V
Add WAIT CTRL + SHIFT + W
Move UP CTRL + UP ARROW
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Move DOWN

CTRL + DOWN ARROW

Delete SELECTION

DEL

Actions

ADD Text

CTRL+SHIFT+T

ADD Barcode

CTRL+SHIFT+B

ADD Matrix code

CTRL + SHIFT+D

ADD Imported File

CTRL + SHIFT +1

ADD Line CTRL + SHIFT + L
ADD Box CTRL+SHIFT +Q
ADD Ellipse CTRL + SHIFT + F
ADD Spline CTRL + SHIFT + N
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Main Menu topic

Sub Menu topic

Acceleration Key

ALIGN Left CTRL+ALT+L
ALIGN Right CTRL+ALT+R
ALIGN Top CTRL+ALT+T

ALIGN Bottom

CTRL+ ALT+B

ALIGN Along X

CTRL+ ALT+ X

ALIGN Along Y

CTRL+ ALT+Y

SPACING Horizontal

CTRL+ ALT+H

SPACING Vertical

CTRL+ ALT+V

FLIP Horizontal

CTRL+ALT +F

Actions FLIP Vertical CTRL+ ALT +E
RESIZE CTRL+ALT+2Z
RESIZE X CTRL+ALT+Q
RESIZE'Y CTRL+ALT+Y
GROUP CTRL+ALT+G
UNGROUP CTRL+ALT+ U
MERGE CTRL+ALT+M
REFRESH CTRL+ALT+A
SELECT ALL CTRL+A
DELETE DEL

Mode WORK Mode / EDIT Mode F2
Zoom IN CTRL + ALT + PAGE UP

Zoom

Zoom OUT

CTRL + ALT + PAGE DOWN
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Zoom ALL CTRL + ALT + HOME
Zoom WINDOW CTRL+ALT + W
Zoom OBIJECT CTRL+ALT+O
LIMIT SELECTION F3
LIMIT ALL F4
START LASER F5
STOP LASER F6
Laser
LASER TEST F7
CONNECT / DISCONNECT -
FROM LASER SYSTEM
SHOW LASER SYSTEM STATUS | F9
Main Menu topic Sub Menu topic Acceleration Key
HELP TOPICS F1
Help
CONTEXT HELP SHIFT + F1
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5.3 Adding New Fonts

Minilase Pro has the ability to use any Windows True Type Fonts.

To add in new fonts, open the Minilase Software, making sure that there are no
laser project files open and and from the top menu select File=>Fonts

|2 Minilase Pra 2.0 ‘._"g_ﬁ;g-_

Rmady T o

You will see the following menu:

Select the file from the system fonts on the left and use the arrow to add them to
the Minilase fonts on the right. When completed click Ok and re-launch the
software to see the new font in alphabetical order under string propreties->fonts
(NOTE: System fonts list shows the available fonts installed on windows under
C:/Windows/Fonts, to add new true type fonts to your widows directory, click and
drag them into the “Fonts” folder.
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6 Creating a Sample Project

6.1 Creating a Sample Project

1. Start by opening Minilase Pro and clicking the icon shown below to create a
new project
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2. This will create a new laser project with a plain work area where you will lay
out the graphics you wish to mark.
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3. Next click on the "Add String” icon to create a new text string.
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4. With the string selected, us the tab system on the right to change your text
and program the size of your text string, as well as the location within the
marking window. Try the following values using the “General” and “String”
Tab to get the results shown below:

Text = Minilase

Maintain Aspect = Checkbox Selected
Height = 5mm

X Position = 25

Y Position = -25
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5. Use the “Fill” selections on the tab for “String” in order to fill your text. Use

the following values to get the results shown below:
Fill Type = Single Line

Fill Angle =90

Fill Space = .06
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6. Next, click anywhere in the black area to deselect the text and then chose
the tab titled laser. *Note that it is important to click off of the text to
deselect before you program the laser settings. Note the appearance of
the tab below, it now references the “plain work” area as opposed to the
text string itself.
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7. Program the laser settings tab with the following settings:
Power = 95
Frequency = 20,000
Speed = 100
Passes =1
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8. Next click on the text string again and click on the icon in the top icon menu
titled “Limits on Selection” to turn on red laser aiming beam outline. This
will create an outline representing the size and location of the text to be
marked inside of your laser system. Visually verify that the box is present
during this step. (Note: you must first make sure your laser is in focus using
the focus finder system, reference the “Quick Start Guide” for this feature

and focusing)
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9. Once you have lined up the text on the material you wish to mark, you may
now click the Round Green Icon to place the software into “Work Mode”.
You may now close the door to your marking system and begin to mark by
click the Round Yellow Icon or by utilizing the “Start” button or the “Easy”
or “Auto” mode feature on your Laser Marking System. (Please reference
the “Quick Start Guide” on instructions for starting the marking sequence
via your machine)

Congratulations! You have created a successful marking project.
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[ Troubleshooting

Troubleshooting Matrix

Most issues that arise with the Minilase software are related to the connectivity

via USB from the PC to the Laser Marking System. The chart below is to help

identify those issues and correct them.

Software has no
connectivity to the Laser
Marking System

Laser System is Powered
Off

The Software will only
communicate with the
Marking System when the
power is ON. Turn the
Power ON.

Software has no
connectivity to the Laser
Marking System

USB has lost connectivity

Click the Connection Icon
to re-establish
connectivity. If the
connection is not
restored, save your
current files, close
Minilase Pro and re-
launch the Software. If
the Connectivity Problem
persists, reboot the
computer and re-launch
the Minilase Pro
Software.

Software has no
connectivity to the Laser
Marking System

USB Cable has come
loose.

Make sure the USB cable
is plugged in securely to
the USB port on both the
PC and the Laser Marking
System.
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Software has no
connectivity to the Laser
Marking System

USB cable is not plugged
into the correct USB
connection on the PC

TYKMA

TECHNODLDGGIES

LA

It is important to utilize
the same USB connection
on the PC every time you
run the system. If not,
the driver may not have
installed properly for the
other USB connections on
the PC, which could
prevent the Software
from connecting to the
Laser Marking System.

FAULT Error is show in
the status bar

Laser Marking System has
an Internal Fault

Shut down the system
and call Technical
Support at 877-318-9562
to Diagnose the Issue.
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TYKMA TECHNOLOGIES Inc.
931 East Water Street
Chillicothe, OH 45601
877-318-9562
www.permanentmarking.com
sales@permanentmarking.com
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